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Using This Book

Audience

Key Terms

This book helps you provide data for reports and explorations. It is for an on-
premises deployment of SAS Visual Analytics 7.3 on Windows, with a non-
distributed SAS LASR Analytic Server. Differences in feature support in the 7.1
and 7.2 releases of SAS Visual Analytics are noted.

This book provides prescriptive guidance and omits advanced features and
special cases. The instructions use general-purpose SAS resources. For
example, data is loaded to the general-purpose LASR library, Visual Analytics
Public LASR, which is preconfigured for maximum availability and ease of use.

You can use this book as a complement to SAS Visual Analytics: Getting Started
with Exploration and Reporting or as a supplement to SAS Visual Analytics:
User's Guide. See the SAS Visual Analytics documentation page at
support.sas.com.

This book makes specialized use of the following terms:

delimited file a text file that contains data that is separated by commas, tabs,
or custom delimiters. Autoload support for custom-delimited
files and tab-delimited files begins in the 7.2 release.

LASR the SAS in-memory analytic and data functionality that SAS
Visual Analytics uses. LASR is an adjective. LASR is not an
acronym.

SAS data set a table that is in the SAS7BDAT file format.

server a non-distributed SAS LASR Analytic Server. The term refers
to a software process, not a machine or other computer
hardware.

spreadsheet Microsoft Excel Workbook (XLSX, XLSM, and XLSB) files and

Microsoft Excel 97-2003 Workbook (XLS) files. Autoload
support for XLSB and XLSM files begins in the 7.2 release.


http://support.sas.com/documentation/onlinedoc/va/index.html
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Orientation

Overview of Tasks for Providing Data
Availability Cycle: Methods by Data Type

Acquire or Verify Your Windows Privileges

a W N =

Acquire or Verify Your SAS Privileges

Overview of Tasks for Providing Data

Task

Acquire
privileges.

Make data
available.

Keep data
available.

Details

Providing data involves interacting with your Windows operating system and your SAS
resources. Before you can provide data, you must have certain privileges in each environment.

Your data is not directly used in reports and explorations. Instead, you load a copy of your data
to memory in the server. In-memory data (in the form of LASR tables) is the only data source
for reports and explorations. Here are the basic load methods:

import point and click to create LASR tables from any supported type of data.

autoload schedule a recurring process to create LASR tables from your spreadsheets,
delimited files, and SAS data sets.

A LASR table is an in-memory copy of your data, so data availability is interrupted if someone
unloads a LASR table or stops the server. To keep data available, ensure that unloaded LASR
tables are reloaded in a reasonable amount of time. Here are the reload methods:

manual for tables that were imported from a server. After you point and click in
reload SAS Visual Analytics Administrator, the data is available again.

reload-on- for tables that were imported as local files or from Facebook, Google

start Analytics, or Twitter. After the server restarts, the data is available again.
autoload for tables that were autoloaded. After a specified time interval elapses, the

data is available again. Autoload requires additional setup.

To reliably provide data, you manage the following cycle of data availability:

initial load - unload 2 reload

First, new data is made available through import or autoload. When LASR tables
are unloaded (because the server stops or someone manually unloads a LASR
table), the data is unavailable. After a manual or automatic reload, the data
becomes available again. The unload-reload sequence occurs repeatedly.
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Availability Cycle: Methods by Data Type

Data Type

SAS data set

Cycle of Data Availability

import local - unload 2 reload-on-start

import server - unload 2 manual reload

autoload - unload 2 autoload
Delimited file or spreadsheet import local - unload 2 reload-on-start
autoload - unload 2 autoload

Database table

import server - unload 2 manual reload

Google Analytics, Twitter, or Facebook import other - unload 2 reload-on-start

For each spreadsheet, delimited file, or SAS data set, you have a choice of
methods. The suggested practice is to use the import local method whenever
possible. With import local, data reloads when the server restarts. No additional
configuration is necessary. If you can’t access your data from your web browser,
or your files are too big to upload through your web browser, the suggested
practices are as follows:

For SAS data sets, use the import server method (in the 7.2 release) or
autoload (in earlier releases).

For spreadsheets and delimited files that are not accessible from your web
browser, use autoload.

For spreadsheets and delimited files that are larger than 4 GB, convert it to
ZIP format and import it as a local text file. If the ZIP file is larger than 4 GB,
use autoload.

To update a LASR table that was created using import local, you must import the
data again. Reload-on-start does not reflect updates to your original data.
Reload-on-start retrieves a backing store copy of your original data. The copy is
created during import.

Note: Manual reload does reflect updates to your original data. To retrieve your
data from its original location, manual reload uses a job or query (a set of
instructions that are created during import).

Note: Reload-on-start support for Facebook and Google Analytics begins in the
7.2 release.

Note: For supported databases, see "Import a Database Table" in the 7.1, 7.2,
or 7.3 edition of the SAS Visual Analytics: User's Guide.


http://support.sas.com/documentation/cdl/en/vaug/67500/HTML/default/viewer.htm#p1ee44qnbsxa2on11zu9jfh5g8ny.htm
http://support.sas.com/documentation/cdl/en/vaug/68027/HTML/default/viewer.htm#p1ee44qnbsxa2on11zu9jfh5g8ny.htm
http://support.sas.com/documentation/cdl/en/vaug/68648/HTML/default/viewer.htm#p1ee44qnbsxa2on11zu9jfh5g8ny.htm
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Acquire or Verify Your Windows Privileges

1. On your SAS Visual Analytics computer, navigate to Start » Control Panel » System and Security
Administrative Tools.

2. Right-click Local Security Policy, and select Open.
Note: If you cannot open Local Security Policy, ask your Windows system administrator for assistance.

¥ Control Panel » Systern and Security » Administrative Tools

F

Mame

fak, iSCS! Initiator

Iiﬁ Local Security Policy
Open |’>

ODBC Data Sources (32-

B AND T Maka Coviemne (64

Open fillé\{-iocatiun

3. Inthe Local Security Policy window, expand Local Policies, and select User Rights Assignment. On
the right, right-click Log on as a batch job, and select Properties.

.E.-!H Security Settings Policy “
I [ g Account Policies 15| Increase scheduling pricrity
4 _é. Local Policies 2o Load and unload device drivers
b —é' Audit Policy lis| Lock pages in memory
_‘g User Rights Assignment i Log on as a batch job
[>_ g Security Options L Log en as a service
I _| Windows Firewall with Advan [ Manage auditing and
| | Metwork List Manager Policie i o it b
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4. If neither your Windows user ID nor SAS Server Users is listed in the Log on as a batch job Properties
window, add yourself to the list. To make the change take effect, log off, and then log back on.

Local Secunty Setting | Explain |

Log an as a batch job

1
Al

Administrators

Backup Operators
Performance Log Users
sasdemo

SASSMV

Add User or Group... ,\\J Remowve
b

5. If your Windows user ID is listed in the Log on as a batch job Properties window, no action is needed.

6. Ifthe SAS Server Users group is listed in the Log on as a batch job Properties window, make sure that
you are a member of that group:

a. Under Control Panel » System and Security » Administrative Tools, right-click Computer
Management, and select Open.

b Control Panel » System and Security » Adrinistrative Tools »

Mame

, Rernote Desktop Services

[#l- Component Services

||‘£E' Computer Management

I’_i'& Defragrment and Optimiz Open I
il Fuent Viewer Open file Bcation
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b. Expand Local Users and Groups, and select Groups. Right-click SAS Server Users, and select

Properties.

(A Computer Management (Local)
4 '[[’u!' System Tocls
[ {E} Task Scheduler
b 2] Event Viewer
t- | Shared Folders
4 & Local Users and Groups
| Users
| Groups
[ @ Performance
gy Device Manager

4 23 Storage

Mame T

:@Users

TS Web Access Computers

:E»Rn?_plicatl:ur Add to Group...

:E« Remote Management Users All Tasks
'Rermnote Desktop U

&% Remote Desktop Users Delete

M RDS Remote Access Servers
#% RDS Management Servers TS

:ke RDS Endpoint Servers

Froperties t

f '{lﬁ} Windows Server Backup :@Prlnt Operators Help
L=8l Mhcl BAananement %"PDWEF Users
c. In the SAS Server Users Properties window, add yourself as a member if your Windows user ID is

not already listed. To make the change take effect, log off, and then log back on.

Members:

Remove

7. Make sure that you have Read and Write access to your equivalent of the following directories:

C:\SAsS\Config\Levl\...

. .AppData\SASVisualAnalytics\VisualAnalyticsAdministrator\sigfiles

. .Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\Monitoring

. .Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\Monitoring\Logs

..Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\Monitoring\PIDs

Acquire or Verify Your SAS Privileges

1. On your SAS Visual Analytics computer, navigate to your equivalent of the following directory:

C:\Program Files\SASHome\SASManagementConsole\9.4



6 Chapter 1 / Orientation

2.

Right-click sasmc.exe, and select Open.

¥ Computer » O5(C:) » Program Files » 5AS5Home » SASManagementConsole » 9.4 »

Mame
G sasmc |
Open
i | =asmc _PE [}S‘
6 sasmc co Pin to Start

Log on to SAS Management Console as the SAS Administrator. Here is an example of the necessary
connection information:

Machine: abc123.company. com
Port: a561

User ID: sasadmi@saspw
Password: I T T

Authentication domain:
Cotional

Save user ID and password in this profile

On the Plug-ins tab, select User Manager.

On the right, clear the Show Groups and Show Roles check boxes.
If you are not listed, go to the next step.

If you are listed, double-click your name, and make sure that your properties are as described in the
remaining steps. No further action is needed.

Plug-ins | Folders | Search

Repository: | [l Foundation W

IE 545 Management Console S esss D Show Groups D Show Roles
= |:| Environment Management

+E Authorization Manager

-5} Data Library Manager

E Foundation Services Manager
1T Metadata Manager

E Publishing Framework

- () Schedule Manager

- B Server Manager

IJser, Group, or Role %
E Search Interface to SAS Content User
& SAS Trusted User
& SAS Environment Manager Service Account
{4 SAS Demo User
& SAS Anonymous Web User
& sAS Administrator

S5} {F}--JF - 75}

5}

| User Manager
>|:| Menitoring
b [ 7 Maintenance
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6. On the Plug-ins tab, right-click User Manager, and select New » User.

Plug-ins | Folders | Search

Repository: | [l Foundation

IS SAS Management Console

- -[_7 Environment Management

+fﬂ Authorization Manager

+E Data Library Manager

+'-'-3.; Foundation Services Manager
+IT1 Metadata Manager

+l‘-|3_'5’ Publishing Framework

+ (L) Schedule Manager

4l [ Server Manager

D Monitoring GS Refresh
|:| Maintenance

N Wil U
=-(_7 Application Manz = |E =
+S§§ Configuratio Ooti L‘é T
oA ptions... 4
+- ] Deployment &= |Role

Authentication Domains...

About User Manager

7. On the General tab, enter your name.

General | Groups and Roles | Accounts I Authorization |

[g Iser | External Identities

MName: Your Mame

8. On the Groups and Roles tab, move the Visual Analytics Data Administrators, Visual Data Builder
Administrators, and SAS Administrators groups to the Member of list.

Available Groups and Roles: Member of:

a& Home; Usage . c@ Visual Analytics Data Administrators
g2 Job Execution: Job Administrator = | |3 visual Data Builder Administrators

é& Job Execution: Job Designer c@ SAS Administrators
= Job Execution: Job Scheduler

a& Job Execution: Job Submitter -

Note: For the purpose of this book, the Visual Analytics Data Administrators group provides all
necessary SAS privileges. The other group memberships are optional.

9. On the Accounts tab, click New to add a login.

a. Enter your Windows user ID in its fully qualified format (userID@domain.extension, domain
\userID, or machine\userlID).

b. Do not enter a password.

c. Select the DefaultAuth authentication domain.
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d. In the New Login Properties window, click OK.

Enter Login information. Enter User IDs for Microsoft Windows in the format of
domain'userid. See help for details.

User ID: |?our]]3@'yourdmain.m

Password: |

Confirm Password: |

Authentication Domain: |Deﬁ:u|t.ﬁ.uﬂ'1

10. In the New User Properties window, click OK.

General | Groups and Roles | Accounts | Authorization |
a User | External Identities |
Name: Your Name |
Display Name: | |
Job Title: | |

OK . || Cancel || Help
o (et | [ |
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Prepare

Prepare 9
Cycle for Locally Imported Data 12
Cycle for Data from a Server 16
Cycle for Autoloaded Data 21
Clean Up 22
Remove demolocalCars 22
Remove demoServerCars 23
Remove the Autoloaded Version of CARS 24

This chapter demonstrates three examples of the availability cycle. Each
example consists of a task sequence that includes a load action (import a local
file, import from a server, or autoload), a manual unload action, and a reload
action. Here are some important details:

For the purpose of demonstration, each task sequence begins with the
server stopped. In practice, you do not stop the server before your load data.

For maximum availability and ease of use, the task sequences use default,
general-purpose output locations.

To get started, complete the following steps:

1 Open a web browser to your equivalent of the following URL:
http://your.computer.name/SASVisualAnalyticsAdministrator

For your exact URL, open the file Instructions.html, and search for sas
Visual Analytics Administrator. This file is in your equivalent of the
directory Cc:\SAS\Config\Levl\Documents\.

2 In the Sign In to SAS window, enter the user ID and password for your
Windows account. Click SIGN IN.

TIP Do not sign in using an internal account, such as sasadm@saspw.
Internal accounts cannot perform tasks that interact with Windows
resources.

3 Set up the suggested display.
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LASR Servers ¥ |

If the LASR Servers tab is not already open, select LASR » Manage
Servers from the main menu.

If the LASR Tables tab is not already displayed, select LASR » Manage
Tables from the main menu.

From the main menu, select View » Tab Layout » Stacked.

nn ;._ Manage Environment ¥

File Wi LASR Tools Help

Lsage Reports...

Tah Layout b | M| * Default -

Falders Ml side-ty-Side
= Stacked . [

by

Filter the LASR Tables tab. Select Library from the drop-down list, and
then enter public in the search field.

If you have a lot of servers, filter the LASR Servers tab. Select Server
from the drop-down list, and then enter public in the search field.

(Optional) Size, hide, and reorder columns on the LASR Servers and
LASR Tables tabs. To hide or show columns, right-click on any column
heading.

Note: Support for hiding columns and remembering your changes begins

in the 7.2 release.

Here is an example of the suggested display:

G % F r n ] Getstatus as tab is initialized cancel Server R4 ‘I,@ Fublic Q-I

|| Server
|| | Fublic LASR Anahtic Semer -

Status

WA_SAMPLE_TELCOO3

0 OLC

WA_SAMPLE_SMALLINSIGHT

LASR Tables * |
W % @ T o d m | [ Getstatus astab is initialized Cancel Library [v|(®Puic )
| | Table v  Status Size Server Library

VA_SAMPLE_WARRANTY_CLAIMS Public LASR Analytic Server - .| Visual Analytics Public LASR

Puhlic LASR Analytic Server- .| Visual Anahtics Public LASR

Fublic LASR Analytic Server- . Yisual Analics Public LASR
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4 On the LASR Servers tab, right-click Public LASR Analytic Server, and
select Get Status.

LASR Servers * |

M % | » m | [ | Getstatus as tab is init

| | Server Status

|_| Public LASR Analytic Server !
Start =
Stop

¥ Get Status N

g
T Load a Table
[£] Last Action Log
Columns »

5 Onthe LASR Tables tab, select the check box at the top of the first column.
Make sure that all listed tables have a checked check box, and then click J.

LASR Tables * |

Wy % @ T oo d @ [ Getstatusa

|¥|  Table ¥  Status
¥ WVA_SAMPLE_WARRANTY_CLAIME
V] VA SAMPLE_TELCOO3

YVA_SAMPLE_SMALLINSIGHT

<

6 \Verify that you can start and stop the Public LASR Analytic Server.

a If the Public LASR Analytic Server is not running, right-click on it, and
select Start.

LASR Servers x|

B % & » B Y| [ Getstatus as tabis initialized Ca

||| Server Status

|| Public LASR Analytic Server ... u

B Start =
Stop

»¥] Get Status

"TJ Load a Table

[E] Last Action Log
Columns [
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b Right-click Public LASR Analytic Server, and select Stop.

CAUTION! Stopping the server unloads all tables. Stop the server only at
a time when other users will not be disrupted.

LASR Servers * |

O % F | » m | [ Getstatus as tab is initialized Ca

|| Server Status

Public LASR Analtic Server .| @
L ','11 Start L

W Stop

»7| Get Status

'y Load a Table

[E] Last Action Log
Columns [

Cycle for Locally Imported Data
1 On your computer, create a text file named demoLocalCars.txt with the

following content:

make,model, quantity
ford, fusion, 232323
toyota, camry, 454545

2 In SAS Visual Analytics Administrator, set up the suggested display.

3 If the Public LASR Analytic Server is running, right-click on it, and select
Stop.

CAUTION! Stopping the server unloads all tables. Stop the server only at a
time when other users will not be disrupted.

4 Import a local file.

a From the drop-down list in the banner, select Report Designer to switch
to SAS Visual Analytics Designer.

Iﬂ vI a Manage Environment ¥ .

Fecent »

fig Data Explorer

E Repart Designer

[& Report viewer I}’

ﬁ. Administrator - Manage Environmmemnt
E¥ Data Preparation
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b On the Data tab, click Select a data source.

(I8 R

File Insert Wiew Help
E = L]
Objects | Data X| Imparts v

| Selecta data source |\ | » |
LA

c In the Import Data panel, click Text Files.

Import Data
Local

Microsoft Excel fxls, *xlsx, “xlsm, *xlsh)
Text Files (F.ogv, Hbd *z7im
SAS Data Set

d Select the demoLocalCars.txt file that you created in step 1. Click Open.

e In the Import Text File window, click OK.

Import Text File x

Source File

Source file: dernolocalCars. b | Browse... |

Delimiter:

(=) Comrma () Semicolon () Space () Tah () Other |:|

|¥] First roww containg column narnes

Diata records begin on row:

Mumber of rows to scan: | 500 @

Encading: |Wilatin1 (Aindows-1252) | v |

Qutput Table

MName: z|dem0LocaICars

Description: Imported on Friday, August 7, 2015 08:34:30 A GMT-0400 from
"demalocalCars bt by"p 3

¥ Advanced

| Preview | | OK || Cancel |
- | S | Sl

Note: When the import is completed, the Data tab is populated.
5 Review the results.

a To switch back to SAS Visual Analytics Administrator, click Manage
Environment in the banner.
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(30 AT N

File Ingert W ey Help

E = H L]
Ohjects | Data x| Impors -
|demDLDcaICars | = |

b On the LASR Servers tab, select Public LASR Analytic Server, right-
click, and select Get Status. Notice that the server is running. The import
request triggered the server to start.

TIP The associated LASR library, Visual Analytics Public LASR, is
preconfigured to autostart on demand for requests to import, load, or
reload data.

c On the LASR Tables tab, click &%. Notice that the new table
DEMOLOCALCARS is listed.

d On the LASR Tables tab, make sure that all check boxes are selected,
and then click y71. Notice that any tables that participate in reload-on-start
are available again.

TIP The associated LASR library, Visual Analytics Public LASR, is
preconfigured to support reload-on-start.

Here is a depiction of the results:

LASR Servers * |

G % || Getstatus as tab is initialized
|| Server A Status
o

[¥| Fublic LASE Analytic Server ..,

LASR Tables * |

W % 7 Yo ¥ @ [ Getstatus astab is initialize

[+  Table &  Status Size
|¥] DEMOLOCALCARS @ 42.00 bytes
| |¥] WA_SAMPLE_ACME_BANE [ ] 256.29 MB
|v] | WA_SAMPLE_BANKCAMPAIG @ 210.27 MB

6 Examine reload behavior.
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a On the LASR Tables tab, right-click DEMOLOCALCARS, and select
Unload.

LASR Tables X|
LY 7l | g + T Get status as tab is initialized
4 * o M L
| | | Table a | Status Size S«
v DEMOLOCALCARS - 42.00 bytes P
Reload
V] | VA_SAMPLE_ACME_E & Unload % 256.28 MB| PL
V| | WA_SAMPLE_BANKCA || DelEte 210.27 MB Pt
VA_SAMPLE_CASING 7] Get Status 1,28 MB P
Vi . 1
V] - - =] Last Action Log
V| | WA_SAMPLE_RETAIL Calumns » 2283MB P
T

b Right-click DEMOLOCALCARS again. Notice that you cannot reload the
table manually.

LASR Tables * |

O % o Yo ® @ [ Getstatus as tab is initialized

| | | Table a | Status Size £
v DEMOLOCALCARS [ = F

Reload .
V] | VA_SAMPLE_ACME_BAN . Unjoad 6620 MB F
] | VA_SAMPLE_BANKCamp O Delete 21027 MB F

vo| Get Status

(V] | VA_BAMPLE_CASINO_RE yy | oot oo 1.28MB F
I\,_fl VA_SAMPLE_K']E_STUD Change Source 1039 mMB F
] | VA_SAMPLE_RETAIL_RG__ olumns Y| zzsIMe F

c On the LASR Servers tab, stop, and then start the Public LASR
Analytic Server.

d On the LASR Tables tab, right-click DEMOLOCALCARS, and select Get
Status.
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LASR Tables * |

W% Yo

4§

=

1
m

| | Table

A | Status

DEMOLOCALCARS

<

[ | Getstatus

Feload

Vi _SAMPLE_ACME

[

VA SAMPLE_BAMNKC

[«

VA SAMPLE_CASIN

[

Vo SAMPLE_K12_S7

[

Vi SAMPLE_RETAIL

Unload

m Delete

4] Get Status

[£] LastAction Log
Change Source
Columns

[«

e Notice that the table reloaded after you restarted the server.

LASR Tables * |

B % o Yo ¥ @ | Getstatus as
| | Table A | Status

V] DEMOLOCALCARS [ ]

Note: If a lot of tables are being reloaded, there might be a slight delay.

TIP For more information, see "Importing Local Data Files" in the 7.1, 7.2, or
7.3 edition of the SAS Visual Analytics: User's Guide.

Cycle for Data from a Server

1 In SAS Visual Analytics Administrator, set up the suggested display.

2 |If the Public LASR Analytic Server is running, right-click on it, and select

Stop.

CAUTION! Stopping the server unloads all tables. Stop the server only at a
time when other users will not be disrupted.
3 Import a SAS data set from a server.

a In the SAS Visual Analytics Administrator banner, click a report to switch

to SAS Visual Analytics Designer.

(I8 T AR

Or, select Report Designer from the drop-down list in the banner.


http://support.sas.com/documentation/cdl/en/vaug/67500/HTML/default/viewer.htm#p0tm08fnqcxiwan1k3ad9uxuugjy.htm
http://support.sas.com/documentation/cdl/en/vaug/68027/HTML/default/viewer.htm#p0tm08fnqcxiwan1k3ad9uxuugjy.htm
http://support.sas.com/documentation/cdl/en/vaug/68648/HTML/default/viewer.htm#p0tm08fnqcxiwan1k3ad9uxuugjy.htm

b

C
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I 1 G I ak Manage Environrment * .
=) »

ecent

fig Data Explorer

E Feport Designer

[@ Report viewer L\)

#u Administrator - Manage Environment
E% Data Preparation

On the Data tab, select Change Data Source from the drop-down list in
the toolbar.

(8] e voreaeEnvormer|

File Insert Wiewy Help
E = H ]
Ohjects | Data x| Imports A
|deanncaICars | = |
* O @ 3
2 I(@ !.: Change Data Source. [}
— wh Mew Higrarchy..

Or, click Select a data source.

e
File Insert Wiew Help

E = [

Objects | Data x| Imports \_ v

| Selecta data source |\ | = |
147

In the Server section of the Import Data panel, click SAS Data Set.

Import Data
Local

Microsoft Excel x5, *xlsx *xlsm, *xlsh
Text Files F.osv, * 4, *2ip
SAS Data Set

Server

SAS Data Sat
MySGL g, ]

Qracle
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d In the Import SAS Data Set on a Server window, select cars.sas7bdat.
Click OK.

The data set is on the SAS Application Server machine in your equivalent
of the following directory:

C:\Program Files\SASHome\SASFoundation\9.4\core\sashelp

Import SAS Data Set on a Server x
Mavigate on the SAS Application Server to select the data setto import.
(SN |

O wweight sas7hdat

D cars sas7hdat
[ class sas7ndat

Basic Properties:
Property Value
Diate rmodified 062515 02:03 Al -
Location CAProgram FilesiSASHome\SASF oundationd. dicarevsashelp
K

Description

L el e

| Cancel |
bs

e Inthe LASR Table section, change the name of the output table to
demoservercars. Click OK.

Import 545 Data Set on a Server x
Source File: cars.sasThdat | Browse...

LASR Tahle

Mame: =|demaservercars

Description:  [Imported on Friday, August 7, 2015 08:57:48 AM GWT-0400 frarm
"cars" by "Hitti, Catherine"

» Acvanced

| OK [ Cancel |
— g

Note: When the import is completed, the Data tab is populated.
4 Review the results.

a To switch back to SAS Visual Analytics Administrator, click Manage
Environment in the banner.
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(I8 T N

File Insert i ey Help

E = d Ll
Objects | Data *| Imports [+
|demusewercars | » |

b On the LASR Servers tab, select Public LASR Analytic Server, right-
click, and select Get Status. Notice that the server is running. The import
request triggered the server to start.

c On the LASR Tables tab, click &%. Notice that the new table
DEMOSERVERCARS is listed.

d On the LASR Tables tab, make sure that all check boxes are selected,
and then click J71. Notice that any tables that participate in reload-on-start
are reloaded.

Here is a depiction of the results:

LASR Servers * |

B % e m [ | Getstatus as tab is initialized
|v]  Server & Status
|v|  Public LASR Analic Serer | L]

LASR Tables * |

B % F Y e ¥ m | Getstatus as tab is initializec

|¥| | Table a  Status Size
V] DEMOLOCALCARS @ 45.00 hytes
|¥] DEMOSERVERCARS @ 66.87 kKB
¥ WA SAMPLE _ACME_BANK @ 256.29 MB

5 Examine reload behavior.

a Onthe LASR Tables tab, right-click DEMOSERVERCARS, and select
Unload.
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LASR Tables * |

B % o Yo ¥ @ [ Getstatus as

|v| | Table a  Status
V| | DEMOLOCALCARS ®
v DEMOSERVERCARS a
L Reload i
V] | VA_SAMPLE_ACME_BA| &, Unload N
V] | VA_SAMPLE_BANKCAM Delete
o7 Get Status
(V] | VA_SAMPLE_CASINO flywy | oo oo
I\_fl U.&._S.&.MPLE_K'IE_STU[ Change Source
] | VA_SAMPLE_RETAIL_R__ Columns »

b Right-click DEMOSERVERCARS again. Notice that you can reload the
table manually. Reload the table.

LASR Tables * |

O % o Yo d @ | Getstatus as

Tahle & | Status
DEMOLOCALCARS [ ]

=

DEMOSERVERCARS ||
(™ Reload L

Unload

WA SAMPLE_BAMNKCAS ﬁ-ﬁ Delete

v7| et Status

[£] Last Action Log

1<

VA SAMPLE_ACME_B:

& K

Vit SAMPLE_CASING_

[<

VA_SAMPLE K12 STU

<

Change Source
WA SAMPLE_RETAIL_F Columns b

<

¢ Right-click DEMOSERVERCARS again. Unload the table.
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LASR Tables *|
B % o Yo ¥ @ [ Getstatus as
|v| | Table a  Status
V| | DEMOLOCALCARS ®
v DEMOSERVERCARS a
Reload i

] | VA_SAMPLE_ACME_BA| &, Unioad N
V] | VA_SAMPLE_BANKCAM Delete

»7| Get Status
(V] | VA_SAMPLE CABINO_H jw \ _oneon o
V] | VA_SAMPLE_K12_STUL  Change Source
] | VA_SAMPLE_RETAIL_R__ Columns ’

d Onthe LASR Servers tab, stop, and then start the Public LASR
Analytic Server.

e Onthe LASR Tables tab, right-click DEMOSERVERCARS, and select
Get Status. Notice that the table did not reload after you restarted the
server. To reload a table that was imported from a server, you must
perform a manual reload.

TIP For more information, see "Importing Data from Servers" in the 7.1, 7.2,
or 7.3 edition of the SAS Visual Analytics: User's Guide.

Cycle for Autoloaded Data

This demonstration is applicable if you have configured and started autoload.

1

2

In SAS Visual Analytics Administrator, set up the suggested display.

If the Public LASR Analytic Server is running, right-click on it, and select
Stop.

CAUTION! Stopping the server unloads all tables. Stop the server only at a
time when other users will not be disrupted.

On the computer where SAS Visual Analytics is installed, copy the data set
cars.sas7bdat from your equivalent of the following directory:

C:\Program Files\SASHome\SASFoundation\9.4\core\sashelp
to your equivalent of the following directory:

C:\SAs\Config\Levl\AppData\SASVisualAnalytics
\VisualAnalyticsAdministrator\AutoLoad

After 15 minutes, review the results.


http://support.sas.com/documentation/cdl/en/vaug/67500/HTML/default/viewer.htm#n0b5lcpsr5d0afn1hgmj3hx3c1r9.htm
http://support.sas.com/documentation/cdl/en/vaug/68027/HTML/default/viewer.htm#n0b5lcpsr5d0afn1hgmj3hx3c1r9.htm
http://support.sas.com/documentation/cdl/en/vaug/68648/HTML/default/viewer.htm#n0b5lcpsr5d0afn1hgmj3hx3c1r9.htm
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Note: This demonstration assumes a task interval of 15 minutes. If the
interval is shorter or if there is a delay between your unload action and your
get status action, autoload might load the table in the interim, leading to a
different sequence of results.

a Onthe LASR Servers tab, select Public LASR Analytic Server, right-
click, and select Get Status. Notice that the server is running. Autoload
triggers the server to start if it is not already running.

b On the LASR Tables tab, click 4%. Notice that the new table CARS is
listed. The Description column indicates that the table was autoloaded.

c Onthe LASR Tables tab, get the statuses of all of the listed tables.
Notice that tables that use reload-on-start are now loaded.

TIP If autoload starts the server, it also triggers reload-on-start.

5 Examine reload behavior.
a Onthe LASR Tables tab, right-click CARS, and select Unload.
b Right-click CARS again. Notice that you cannot reload the table manually.

c Onthe LASR Servers tab, stop, and then start the Public LASR
Analytic Server.

d On the LASR Tables tab, right-click CARS, and select Get Status.
Notice that the table did not reload after you restarted the server.

e After the scheduled task interval has elapsed, get the status of the CARS
table again. Notice that the table is now loaded. The most recent run of
autoload identified that autoload’s drop zone copy of CARS was not
loaded, so it loaded that table again.

Clean Up

Remove demolLocalCars

1 On the LASR Tables tab, click DEMOLOCALCARS to get its status. If the
table is loaded, right-click on it, and select Unload.

2 On the LASR Tables tab, right-click DEMOLOCALCARS, and select Delete.
In the confirmation window, click Delete.

3 On your SAS Visual Analytics computer, navigate to your equivalent of the
following directory:

C:\SAs\Config\Levl\AppData\SASVisualAnalytics
\VisualAnalyticsAdministrator\PublicDataProvider

4 Right-click demoLocalCars, and select Delete.

Note: During each import of a local file, SAS creates a data set copy of the
source file to support reload-on-start.
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)« SAS » Config » Levl » AppData » SASVisualAnalytics » VisualAnalytics

Mame

Eﬂ demaolocalcars
EE va_sample_acme_bank
Eﬂ va_sample_bankcampaig Open with SAS Enterprise Guide 7.11

Open

Eﬂ va_sample_casino_rev_fc Browse with 5A5 9.4
E va_sample_k12_student Print

EE va_sample_retail_ro_cost Print with 545 9.4
EE va_sample_retail_ro_md_ &= forirses,

E va_sample_retail_ro_pron Open with...
Eﬂ va_sample_smallinsight
EE va_sample_telcol3

Eﬂ va_sample_warranty_clail

Restore previcus versions
Send to r
Cut

Copy
Create shortcut

Delete

&

Rename

Properties

Remove demoServerCars

1 On the LASR Tables tab, click DEMOSERVERCARS to get its status. If the
table is loaded, right-click on it, and select Unload.

2 On the LASR Tables tab, right-click DEMOSERVERCARS, and select
Delete. In the confirmation window, click Delete.

3 On the Folders tab in SAS Management Console, navigate to SAS Folders
Shared Data » SAS Visual Analytics » Public » LASR.

4 Right-click the DEMOSERVERCARS data query, and select Delete. In the
confirmation window, click Yes.

Note: During each import from a server, SAS creates a data query or job
that contains instructions for accessing the source file to support manual
reload.
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Folders I_ | Mame |

1§ SAS Folders ] DEMOSERVERCARS Wigy
+-[ @ My Folder By  Copy
+-[_ | Products X
: . Delete
= [:l Shared Data | [ |
- =[] 5AS Visual Analytics Rename
*% Autoload (2  Export SAS Package...
=[] Public
: Properties
.77 Ruckam

Remove the Autoloaded Version of CARS

1 On your SAS Visual Analytics computer, navigate to your equivalent of the
following directory:

C:\sAs\Config\Levl\AppData\SASVisualAnalytics
\VisualAnalyticsAdministrator\AutoLoad

2 Right-click cars.sas7bdat, and select Delete.

3 Onthe LASR Tables tab, click the autoloaded version of the CARS table to
get its status. If the table is loaded, right-click on it, and select Unload.

4 On the LASR Tables tab, right-click the autoloaded version of the CARS
table, and select Delete. In the confirmation window, click Delete.
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Who Should Use Autoload?

Introduction

In many cases, import, reload-on-start, and manual reload functionality is
sufficient. Before you invest in setting up autoload, make sure that you have a
good reason to use autoload and that you understand autoload’s limitations.

What Does Autoload Do?

If autoload is running, it periodically makes sure that all of the data in a particular
Windows folder is available for use in reports and explorations.

Here are autoload’s basic activities:
If the server is stopped, autoload starts it.
If a table is not loaded, autoload loads it.

If the loaded copy of a table is older than the table in the folder, autoload
refreshes it, updating the in-memory data to reflect the data in the folder.

For a comprehensive description of autoload functionality, see the SAS Visual
Analytics: Administration Guide.
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Reasons to Use Autoload
Consider using autoload in any of the following circumstances:

You want the server to start automatically instead of starting only manually
(from the LASR Servers tab) or indirectly (as a side effect of an import
request).

You want your spreadsheets, delimited files, and SAS data sets to be
available on a scheduled, automatic basis.

You have spreadsheets, delimited files, or SAS data sets that are larger than
4 GB (even in ZIP format).

Note: For SAS data sets, an alternative is to import from a server.

Limitations of Autoload
Before you set up autoload, review the following limitations:

Autoload is not a universal method. You cannot autoload ZIP files, database
tables, or data from Google Analytics, Facebook, or Twitter.

For spreadsheets, autoload is less flexible than import. For a spreadsheet
that has multiple worksheets, only the first worksheet is loaded. Autoload
assumes that the first row contains column headings and begins data import
with the second row.

Autoload requires some manual maintenance. A new autoload log file is
generated every time autoload runs. You must periodically empty your
equivalent of the following directory:

C:\SAs\Config\Levl\Applications\SASVisualAnalytics
\VisualAnalyticsAdministrator\Logs

Each implementation of autoload provides data to a particular LASR library.
To autoload data to another LASR library, you must set up an additional
implementation of autoload.

How to Set Up and Start Autoload

Introduction

Use these instructions if you want to autoload data to the general-purpose LASR
library, Visual Analytics Public LASR. The Visual Analytics Public LASR library is
preconfigured for autoload, so there are only two additional setup tasks:

Enable an account to schedule and run autoload. Autoload interacts with
both your Windows file system and your SAS resources, so it must run as a
Windows account that has a corresponding individual SAS identity.

Start autoload as a scheduled task. SAS provides a batch file that creates
and starts a scheduled task for autoload. The task uses Windows Task
Scheduler. After you start the task, it runs every 15 minutes (unless you
customize the task interval).
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Identify the Windows account that installed SAS Visual Analytics on your computer.

Note: These instructions reuse the account that installed SAS Visual Analytics (the installer) for the
autoload scheduler because the account already exists and has the necessary Read and Write access in
Windows. If you do not know the account’s user ID and password, you can use a different account.

Give the account the necessary Windows privileges.

a. On your SAS Visual Analytics computer, navigate to Start » Control Panel » System and

Security » Administrative Tools.

b. Right-click Local Security Policy, and select Open.

v Control Panel » System and Security » Administrative Tools »

Mame

—

fak i5CS! Initiator

@ Local Security Policy

Open -

ODBC Data Sources (32-

g ML Miada Caniemmr FRA

Open fill‘éﬁocatiun

I

Note: If you cannot open Local Security Policy, ask your Windows system administrator for

assistance.

C. In the Local Security Policy window, expand Local Policies, and select User Rights
Assignment. On the right, right-click Log on as a batch job, and select Properties.

ig, Security Settings Policy
b g Account Policies
4 [ 4 Local Policies

b g Audit Policy

b g Security Options
oL Windows Firewall with Advan

le| Log on as a service

. ) | s Manage auditing and
| Metwork List Manager Policie o e e

Y

15 Increase scheduling pricrity

171y Load and unload device drivers
i ls) Lock pages in memory

4 User Rights Assignment [#] Log on as a batch job
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d. In the Log on as a batch job Properties window, add the account to the list of users and groups.

Local Securty Setting | Explain |

jl Log on as a batch job

Administrators

Backup Operators
Performance Log Users
sasdemo

sasary

1]
!
]

Add User or Group... ,\‘J R
54

e. Make sure that the account has Read and Write access to your equivalent of the following
directories:

C:\SAs\Config\Levl\...
...AppData\SASVisualAnalytics\VisualAnalyticsAdministrator\AutoLoad
...AppData\SASVisualAnalytics\VisualAnalyticsAdministrator\sigfiles
...Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\
...Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\Monitoring
...Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\Monitoring\Logs

...Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\Monitoring\PIDs

3. Set up a corresponding SAS identity for the account.

a. On your SAS Visual Analytics computer, navigate to your equivalent of the following directory:

C:\Program Files\SASHome\SASManagementConsole\9.4

b. Right-click sasmc.exe, and select Open.

b Computer » O5(C) » Program Files » SASHome » 5ASManagementConsole » 94 »

F

Mame

G sasmc
0

ik | sasmc = [}\_.,‘
Pin to Start

5. sasmc co
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c. Log on to SAS Management Console as the SAS Administrator. Here is an example of the
necessary connection information:

Machine: abc123. company. com
Paort: 83561

User ID: sasadmi@saspw
Password: rERRERES

Authentication domain:
Oofional

Save user ID and password in this profile

d. On the Plug-ins tab, right-click User Manager, and select New » User.

Plug-ins | Folders | Search

Repository: | [l Foundation

IE SAS Management Cansale

- [:l Environment Management

+E Authorization Manager

+E Data Library Manager

+E Foundation Services Manager
+E Metadata Manager

+E Publishing Framewaork

+E schedule Manager

+- [ Server Manager

I:l Monitoring L3 Refresh
L. [ Maintenance

N i U
3-[_7] application Manz| W |E &
4888 Configuratio Outi i Group
— ptions... oo
+1- @ Deployment o ] i ole
_ Authentication Domains... e

About User Manager

e. On the General tab, enter a name such as Autoload Scheduler.

General | Groups and Roles | Accounts I Authorization |

& Lzer | External Identities
Mame: Autoload Scheduler
f. On the Groups and Roles tab, move the Visual Analytics Data Administrators group to the

Member of list.
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g.

h.

On the Accounts tab, click New to add a login.

= Enter the account’s Windows user ID in its fully qualified format (userID@domain.extension,
domain\userID, or machine\userID).

= Do not enter a password.
= Select the DefaultAuth authentication domain.
In the New Login Properties window, click OK.

Enter Login information. Enter User IDs for Microsoft Windows in the format of
domainuserid, See help for details,

User ID: |ir1513||er@-yuurdnmain.::om |

Password: | |

Confirm Password: | |

Authentication Domain: | DefaultAuth

In the New User Properties window, click OK.

General | Groups and Roles | Accounts | Authorization
& User External Identities |
Name: Autoload Scheduler |
Display Name: | |
Job Title: | |
[ [ ] [ |

Start the Scheduled Task

1. Log on to your SAS Visual Analytics computer as the autoload scheduler.

2. Navigate to your equivalent of the following directory:

C:\sAs\Config\Levl\Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\



3.

4.

5.
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Right-click schedule.bat, and select Open.

| SAS -

Mame
|, Config =
Levl &5 runsas
. Lev :
AonD schedule
) ata =
Appl' . unschedule Open &
) ications :
PP . . ] Autoload_u Edit
, SASInformationRetrievalStudioforSAs oo Pri
_ _ Autoload rint
| SASVisualAnalytics [%] Autoload ®  Run as administrator
. HighPerformanceConfiguration
. . i . EVDMLA Scan for Viruses...
J Visual&nalytics&dministrator VALIBLA _ _
. EVDMLA ¢ T Restore previous versions
Verify that the scheduled task is running.
a. Select Start » Control Panel » System and Security » Administrative Tools.

b. Right-click Task Scheduler, and select Open.

b Control Panel » Systern and Security »  Administrative Tools

-

Mame

@‘ Windows Firewall with Advanced Security
@:' Task Scheduler

Open
(@l System Informatiol PER I
—_ - . - - ) Open filrglncatinn
C. In the Task Scheduler window, select Task Scheduler Library. Locate the task Visual Analyt
Hi-Perf Cfg - Auto Load Scheduler, and verify that its Status value is Ready (or
Running).
[.1) Task Scheduler (Local) Name Status

I | Task Scheduler Li%rar_f

i Visual Analyt Hi-Perf Cfg - Auto Load Scheduler Ready

Verify that autoload is working.

a. Copy a spreadsheet, delimited file, or SAS data set to your equivalent of the following directory:
C:\SAs\Config\Levl\AppData\SASVisualAnalytics\VisualAnalyticsAdministrator
\AutoLoad

b. After 15 minutes, use the LASR Tables tab to verify that the data is loaded and available as a data

source.
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Run Autoload More Often or Less Often

4.

If you are testing autoload, you might want to save time by running the task
every two minutes. If you rarely have new data, stop the server, or unload
autoloaded tables, you might want to conserve system resources by running the
task every 240 minutes (4 hours). To change the task interval, complete the
following steps:

Navigate to your equivalent of the following directory:

C:\sAs\Config\Levl\Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\
Make a backup copy of schedule.bat.

Right-click schedule.bat, and select Edit.

. SAS - MName
. Confi .
9 unschedule
, Levl = ..
AonD 4] schedule_backupQfQriginal
' ata :
AF'Fil. ) schedule
! ications -
PP _ _ _ [&] runsas Open
. SASInformationRetrievalStudioforSAl - | Edit
CACVisualAnalvti Autoload_ hi.
. isualAnalytics :
) ¥t ) ) @ Autoload | .
. HighPerfoermanceConfiguration @AutaLnad ®  Run as administrator
. VisualAnalyticsAdministrator i
. VALIBLA Scan for Viruses...
. EVDMLA e
| Logs + Monitoring Share with
| Logs S S JU

Change the value of the TIME_INTERVAL_MINUTES= setting. Save and close the file.

Becho off

REM ",
REM | Schedule AutolLoad.sas

REM M ————mmmmm e wy

set RUNSAS_PATH="C:“wsashConfighlLevlsappTicationshsasvisualanalytics
“wisualanalyticsadministratoryrunsas., bat”
set TIME_IWNTERVAL_MIMUTES=LS

schtasks fcreate S Stn "wisual Ana'lyt Hi-rerf cfg - aAuto Load
Sscheduler"” Str "BRUNSAS_PATH%" /sc minute Smo BTIME_INTERVAL_MIMUTESH
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5. To restart autoload with the new interval, right-click schedule.bat, and select Open.

| SAS -

Mame
' CT_HFI? [E] runsas
. Lev .
- schedule
) ata =
r:lp. . [Z] unschedule Open
. Applications [ AutoLoad_u Edit @
. SASInformationRetrievalStudicforSAS A tol. d_ Print
_ _ g Autcloa
} SASVisualAnalytics @AutnLDad '&' Run as adrninistrator
. HighPerformanceConfiguration EVDMLA
. Scan for Viruses...
J Visual&nalytics&dministrator
L . VALIBLA Restore previous versions
. EVDMLA e

6. Inthe Triggers column in Task Scheduler, verify that the new interval is in effect. For example, the trigger
details indicate a three-minute interval as follows:

After triggered, repeat every 00:03:00 indefinitely.

Note: If Task Scheduler is already open, you might need to refresh the display to see the interval change.
Make sure that Task Scheduler Library is currently selected, and then select Action » Refresh from the
main menu.

Configure Autoload for Seamless Restart

When your computer stops, autoload stops. After your computer restarts and the
autoload scheduler account logs on, autoload starts. If you want autoload to
restart seamlessly each time your computer restarts, complete the following
steps:

1. In the Task Scheduler window, right-click the autoload task, and select Properties.

Mame Status
Visual Analyt Hi-Perf Cfg - Auto Load Scheduler

B
ey

Run
End
Disable
Export...

Properties M
Delete h
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2. On the General tab, select Run whether user is logged on or not, check Do not store password, and
click OK.

Security options

When running the task, use the following user account:

Change User...

() Run only when user is logged on
® Run whether user is logged on or not

Do not store password. The task will only have access to local computer resources,

[] Run with highest privileges

3. Navigate to your equivalent of the following directory:
C:\sAs\Config\Levl\Applications\SASVisualAnalytics\VisualAnalyticsAdministrator\

4. Right-click schedule.bat, and select Edit.

T - Mame
. Config
s unschedule
 Levl ..
| schedule_backupOfCriginal
, AppData
| schedule
. Applications Open
5| runsas
. SASInformationRetrievalStudioforSAS | Edit
S ASVicualAnalti @Autumad_ D‘i
. isualAnalytics :
] ¥t ] ) @ Autoload S
. HighPerformaneceConfiguration Autu:uLu:uau:I ®  Run as administrator
. VisualAnalyticsAdministrator i
. VALIBLA Scan for Viruses...
. EVDMLA L
| Logs . Menitoring Share with
| Logs S S JU

5. Notice that the batch file does not reflect changes that you made in Task Scheduler. If you modify a task
in Task Scheduler, use Task Scheduler to start and stop the task (instead of using the batch file that SAS
supplies). For example, to stop a scheduled task in Task Scheduler, right-click on the task, and select
Disable. To restart the task, right-click on it, and select Enable.

6. Verify that autoload is still running successfully. If autoload can no longer access the drop zone, either
clear the Do not store password check box or set the task to run only when the autoload scheduler
account is logged on.
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About the Import Data Panel

Here is an example of the Import Data panel in SAS Visual Analytics Designer
and SAS Visual Analytics Explorer:

Import Data

Local

Microsoft Excel (*.xls, *xlsx *xlsm, *xlsh)
Text Files (*.csv, * b *7ip)
5AS Data Set

Server

SAS Data Set

MySQL

Cracle

Other

Facebook

Google Analytics

Twitter

The source types that are used in the first two demonstrations are highlighted.

In addition to SAS data sets, the Server list includes any additional data sources
that are licensed, configured, and available to you. In this example, the
additional data sources are MySQL and Oracle.

For information about supported databases, see "Import a Database Table" in
the 7.1, 7.2, or 7.3 edition of the SAS Visual Analytics: User's Guide.


http://support.sas.com/documentation/cdl/en/vaug/67500/HTML/default/viewer.htm#p1ee44qnbsxa2on11zu9jfh5g8ny.htm
http://support.sas.com/documentation/cdl/en/vaug/68027/HTML/default/viewer.htm#p1ee44qnbsxa2on11zu9jfh5g8ny.htm
http://support.sas.com/documentation/cdl/en/vaug/68648/HTML/default/viewer.htm#p1ee44qnbsxa2on11zu9jfh5g8ny.htm
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About the List of Data Sources

Here is an example of the list of data sources in SAS Visual Analytics Designer
and SAS Visual Analytics Explorer:

Data Sources (®va Y%
Name Location @
WA SAMPLE_RETAIL_RCO_MD_CANMDIDATE Products/SAS Visual Anal...
WA, SAMPLE_BANKCAMPAIGN Products/SAS Visual Anal...

VA SAMPLE_CASING _REY _FCST2 Products/SAS Visual Anal...
WA, SAMPLE_K12_STUDENT Products/SAS Visual Anal...
VA SAMPLE_RETAIL_ROC _COST_GT_COMP Products/SAS Visual Anal...
WA SAMPLE_ACME_BANK Products/SAS Visual Anal...
WA SAMPLE_RETAIL_RO PROMO_EFFCTV Products/SAS Visual Anal...
WA SAMPLE_SMALLINSIGHT Products/SAS Visual Anal...
WA, SAMPLE_TELCOO3 Products/SAS Visual Anal...
WA SAMPLE_WARRANTY _CLAIMS Products/SAS Visual Anal...

10 data sources found

Here are some details:

You can use the search field to filter the list to include only tables that have a
name, description, or location value that begins with the characters that you
enter.

The list includes all LASR tables that you have permission to see—
regardless of whether the data is loaded or the server is running. If you select
a data source that is not currently loaded, and you then click Add in the Add
Data Source window, an error message indicates that the data source is not
accessible.

SAS Visual Analytics Designer x

The data source (DEMOLOCALCARS) is not
accessible. Torestore the data source, please contact
your system administratar.

The 7.3 release includes sample tables (VA_SAMPLE_*) that participate in
reload-on-start.



Where to Find Additional Documentation 37

About SAS Visual Data Builder

The data import functionality that this document describes is available in SAS
Visual Analytics Designer, SAS Visual Analytics Explorer, and SAS Visual Data
Builder. SAS Visual Data Builder also enables you to enhance data before it is
used in reports and explorations. For example, you can use SAS Visual Data
Builder to join tables, create calculated columns, append data, subset data, and
sort data.

SAS Visual Data Builder is documented in SAS Visual Analytics: User's Guide.

Where to Find Additional Documentation

The most current technical resources for SAS Visual Analytics are available on
the SAS Visual Analytics page on support.sas.com.

Your experience with SAS software should be as smooth as possible. Please
submit your feedback.


http://support.sas.com/software/products/va/index.html
http://support.sas.com/feedback/form?http://support.sas.com/techsup/index.html
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